Contents

Section 1: General Information
Introduction ........................................................................................................2
Contacting Noyes Customer Service ..............................................................2
System Requirements ..........................................................................................3
Installing Trace.Net .............................................................................................3
Starting Trace.Net .............................................................................................5

Section 2: Trace.Net Screens and Menus
Main Screen .......................................................................................................6
Menu Bar .............................................................................................................9
  File Menu .........................................................................................................9
  Event Menu .....................................................................................................11
  View Menu .....................................................................................................13
    Options Dialog Box .......................................................................................14
  Help Menu .....................................................................................................15
Toolbar ...............................................................................................................16
Trace Graph Window ........................................................................................18
Event Table Window .........................................................................................20
Keyboard Shortcuts ............................................................................................22
Section 3: Transferring Trace Files to a PC

- Traces Saved with M200 OTDR ............................................................... 23
- Traces Saved with M200 OTDRs ............................................................. 25
  - Transferring Traces From M200 via USB Function port to PC ........... 25
  - From CompactFlash card or USB Flash drive to PC ....................... 25
- Traces Saved with OFL250/OFL280 OTDRs .......................................... 26
  - To Transfer Files Using OFL2Go....................................................... 26
  - To Transfer Files Using a USB Cable ............................................. 26
- Traces Saved with OFL 200 OTDR ......................................................... 27
  - OFL 200 File Transfer Dialog Box .................................................. 27
  - Transferring Traces ..................................................................... 30

Section 4: Managing Trace Files

- Opening Trace Files ........................................................................ 31
  - Single-Wavelength or Multi-Wavelength ........................................ 31
- Opening Trace Files ........................................................................ 32
  - Opening a Single-Wavelength Trace .............................................. 32
  - Opening a Multi-Wavelength Trace ............................................... 33
  - Opening Previous or Next Traces ................................................... 34
- Comparing Traces with a Baseline Trace ........................................ 34
Section 5: Analyzing Traces

Closing Files with Changes

Moving Cursors and Zooming
- Selecting the Active Cursor
- Moving the Active Cursor
- Zoom In and Out of a Trace
- Un-zoom and Re-zoom the Trace Display

Selecting Loss Method
- Positioning Cursors Correctly
  - Two Point Loss Method
  - Single Event Loss Method
  - Multiple Event Loss Method
  - Fiber Attenuation Loss Method
  - Start Loss Method (No Launch Cable)
  - End Loss Method (No Receive Cable)

Adjusting LSA Lines

Adding Manual Events

Editing Comments

Deleting Events
Section 6: Printing Trace Reports

Printing a Single Report .............................................................. 55
Printing Multiple Trace Reports - Batch Printing ....................... 56
  Batch Print Dialog Box .............................................................. 56
  Selecting Traces for Batch Print ............................................... 58
  Creating a Cover Page for your Batch Print Job ....................... 60
Section 1: General Information

Introduction

Trace.Net is a Windows®-based application designed to view, analyze, edit, and print trace files saved with Noyes OTDRs.

Note: Trace.Net is not licensed software; you are free to copy it as needed. Please check our web site at www.AFLtele.com/go/Noyes/Software for software updates and additional application information.

This User’s guide contains detailed information about Trace.Net tools and commands and assumes you have a working knowledge of your computer and standard Windows menus and commands. For help with any of these techniques, please see your Microsoft Windows documentation.

If you have any questions about your Noyes OTDR and Trace.Net software, or if you need technical or sales support, please contact Noyes Customer Service.

Contacting Noyes Customer Service

You may contact Noyes Customer Service between 8 a.m. and 5 p.m., United States Eastern Time, as follows:

Phone: 800-321-5298 (North America) • 603-528-7780
Fax: 603-528-2025
Web: www.AFLtele.com/go/Noyes
E-mail: NOYTechSupport@afltele.com
System Requirements
To use Trace.Net application, you need the following hardware and software:

- A PC with a 1GHz (or faster) processor and an 800 x 600 (or larger) display
- A CD or DVD drive if installing from CD
- At least 1 GB of RAM
- A Windows® compatible pointing device (mouse, trackball, etc.)
- MS Windows® 2000, XP or Vista

Installing Trace.Net
You can install Trace.Net from the supplied CD-ROM, or you can download it from our web site at www.AFLtele.com/go/Noyes/Software

Follow the steps below to install the Trace.Net software.

To install from the application CD-ROM:

1. Start Windows. If Windows is running, quit all applications.
2. Insert the Trace.Net CD into the CD-ROM drive. (Note: normally the D: drive.)
3. The Installer will display the [Welcome] screen.
   
   **Note:** If the Installer does not start automatically, from Windows do one of the following:
   - Click on the [Start] button and select the [Run] command from the pop-up menu.
   - The [Run] dialog box appears. On the [Open] command line, type [D:\setup.exe].
• Click on the [OK] button to start.

OR

• Double-click the My Computer icon on the desktop to open the My computer folder.
• Double-click the CD-ROM icon.
• Double-click [Setup] or [Setup.exe]

4. When the Installer [Welcome] screen is displayed, click on the [Next] button to continue.
5. Follow the on-screen instructions.
6. When the Installer displays the [Complete] screen, click on the [Finish] button.

To download from the web:

1. From the www.AFLtele.com web site, select the following:
2. Follow the on-screen instructions. The software will download to your computer’s hard drive.
4. When the Installer [Welcome] screen is displayed, click on the [Next] button to continue.
5. Follow the on-screen instructions.
6. When the Installer displays the [Complete] screen, click on the [Finish] button.
Starting Trace.Net

Follow the steps below to start the Trace.Net application:

1. In Windows, click on the [Start] button.

2. From the [Start] pop-up menu, select the [All Programs] menu.

3. Locate the Noyes Test & Inspection folder.


   If you have installed the Trace.Net application in a folder other than Noyes Test & Inspection, choose that folder from the Start > Programs menu.
Section 2: Trace.Net Screens and Menus

This section provides an overview of key features of the Trace.Net software.

Main Screen

The Trace.Net main screen is divided into several sections. Each section contains a specific type of information (refer to Figure 2-1). The table below gives a summary of the [Main] screen features.

<table>
<thead>
<tr>
<th>Ref</th>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Menu bar</td>
<td>Displays the available pull down menus.</td>
</tr>
<tr>
<td>2</td>
<td>Toolbar</td>
<td>Contains several icons for quick access to menu commands. Click on an icon to execute the associated command.</td>
</tr>
<tr>
<td>3</td>
<td>Zoom window</td>
<td>Shows the current trace view relative to the entire trace.</td>
</tr>
<tr>
<td>4</td>
<td>Cursors data</td>
<td>This field displays the following information: A and B cursor locations, distance from A to B, selected loss method, and (depending on the selected loss method) insertion loss, reflectance, or fiber attenuation.</td>
</tr>
<tr>
<td>5</td>
<td>OTDR /Text data</td>
<td>This field displays OTDR setup parameters or Text data when the associated tab [Trace Info] or [Text Info] is selected.</td>
</tr>
<tr>
<td>6</td>
<td>[Trace Info] tab</td>
<td>Click on this tab to display OTDR setup parameters stored in the selected trace file.</td>
</tr>
<tr>
<td>7</td>
<td>[Text Info] tab</td>
<td>Click on this tab to display test notes stored in the selected trace file.</td>
</tr>
</tbody>
</table>
Figure 2-1: Trace.Net Main Screen.
<table>
<thead>
<tr>
<th>Ref</th>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>[Edit Trace Info] button</td>
<td>Click on this button to display the Edit Trace Information window, which allows editing of the Trace and Text info for the selected trace file.</td>
</tr>
<tr>
<td>9</td>
<td>[Event Table] window</td>
<td>Displays saved events in a table format.</td>
</tr>
<tr>
<td>10</td>
<td>[Trace graph] window</td>
<td>Shows a graph of the currently selected trace. Up to six traces can be displayed in the [Trace graph] window.</td>
</tr>
<tr>
<td>11</td>
<td>Tab of the currently selected trace</td>
<td>If several trace files are opened, click the desired trace tab to display the corresponding trace graph.</td>
</tr>
</tbody>
</table>
Menu Bar

The Menu Bar contains several pull down menus as follows:

Each menu contains various commands. When a menu is selected, it displays a list of commands indicating functions that can be performed on selected files.

File Menu

The File pull down menu contains commands for opening, saving, printing, editing, and closing trace files. The table below gives a summary of the available File Menu commands and their associated functions.

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Trace... Ctrl+O</td>
<td>Depending on the user preference setting (Edit &gt;Preferences &gt; Single-Wavelength or Multi-Wavelength), open a single trace file or a multiple trace file.</td>
</tr>
<tr>
<td>Open Baseline... Ctrl+B</td>
<td>Depending on the user preference setting (Single-Wavelength or Multi-Wavelength), open a single trace file or a multiple trace file as a baseline.</td>
</tr>
<tr>
<td>Next File Ctrl+N</td>
<td>Open the next (alphanumerical) file or pair in the current folder.</td>
</tr>
<tr>
<td>Previous File Ctrl+P</td>
<td>Open the previous (alphanumerical) file or pair in the current folder.</td>
</tr>
<tr>
<td>Save Ctrl+S</td>
<td>Save a trace file that already exists with its original name.</td>
</tr>
<tr>
<td>Command</td>
<td>Function</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Save As...</td>
<td>Save an existing trace file under a new name and preserve the original file.</td>
</tr>
<tr>
<td>Close</td>
<td>Depending on the selected option for closing files, close selected files after automatically saving changes, or prompt the user to confirm saving.</td>
</tr>
<tr>
<td>Close All</td>
<td>Close all open trace &amp; baseline files.</td>
</tr>
<tr>
<td>Print</td>
<td>Select print style and print the currently displayed trace.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Preview an OTDR Trace before printing.</td>
</tr>
<tr>
<td>Batch Print...</td>
<td>Allows printing of all or selected trace files in the current folder.</td>
</tr>
<tr>
<td>Edit Trace Info...</td>
<td>Allows editing of trace text information and certain setup parameters.</td>
</tr>
<tr>
<td>M200 Trace File Transfer...</td>
<td>Allows transferring files from/to M200 OTDR.</td>
</tr>
<tr>
<td>OFL200 Trace File Transfer...</td>
<td>Allows transferring files from the OFL200 OTDR.</td>
</tr>
<tr>
<td>Exit</td>
<td>Close opened trace files and exit Trace.Net.</td>
</tr>
</tbody>
</table>
Event Menu

The Event pull down menu contains all the commands you will need to select loss methods, add new events, and review or delete saved events.

- Add Event
- Loss Method
- Current Event
- Next Event
- Previous Event
- Delete All Events
- Restore Event
- Auto Events
- Re-Calc Pass/Fail Thresholds
- Restore LSA Defaults

- Two Point
- Single Event
- Multiple Event
- Fiber Attenuation
- Start
- End

- Edit Comment..,
- Delete
The table below gives a summary of the available Events menu commands and associated functions.

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Event... Ctrl+A</td>
<td>Add an event using the selected Loss Method at the active cursor location (not available for the Two Point or Fiber Attenuation methods)</td>
</tr>
<tr>
<td>Loss Method</td>
<td>Select the desired Loss Measurement Method.</td>
</tr>
<tr>
<td>Current Event:</td>
<td></td>
</tr>
<tr>
<td>• Edit Comment</td>
<td>Open a dialog box for adding and/or editing comments for the current event.</td>
</tr>
<tr>
<td>• Delete</td>
<td>Delete the current event.</td>
</tr>
<tr>
<td>Next Event</td>
<td>Display the next event: moves the active cursor to the next event and highlight this event in the event table.</td>
</tr>
<tr>
<td>Previous Event</td>
<td>Display the previous event: moves the active cursor to the previous event and highlight this event in the event table.</td>
</tr>
<tr>
<td>Delete All Events</td>
<td>Delete all saved events in the selected trace.</td>
</tr>
<tr>
<td>Restore Event Shift+Ins</td>
<td>Restore the last event that was deleted.</td>
</tr>
<tr>
<td>Auto Events...</td>
<td>Generate an event table.</td>
</tr>
<tr>
<td>Re-Calc Pass/Fail Thresholds</td>
<td>Edit Pass/Fail event and link Thresholds and recalculate events data.</td>
</tr>
<tr>
<td>Restore LSA Defaults</td>
<td>Restore LSA line lengths to the default values.</td>
</tr>
</tbody>
</table>
View Menu

The View pull down menu contains all the commands needed to magnify or reduce the display of any area in the [Trace graph] window, switch the active cursor, turn the Toolbar text on/off, and set up options. The table below gives a summary of the available View menu commands and associated functions.

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom in Horizontally</td>
<td>Alt+Right</td>
</tr>
<tr>
<td>Zoom out Horizontally</td>
<td>Alt+Left</td>
</tr>
<tr>
<td>Zoom In Vertically</td>
<td>Alt+Up</td>
</tr>
<tr>
<td>Zoom out Vertically</td>
<td>Alt+Down</td>
</tr>
<tr>
<td>Un-Zoom</td>
<td>F6</td>
</tr>
<tr>
<td>Re-Zoom</td>
<td>F7</td>
</tr>
<tr>
<td>A-B Cursor</td>
<td>F4</td>
</tr>
<tr>
<td>Options</td>
<td>F4</td>
</tr>
</tbody>
</table>

Switch the active cursor

View Toolbar Text

Turn the Toolbar text on or off

Options

Use to select the appearance of traces and how they are opened/closed/saved. Also, use this command to choose how to download Trace.net updates. See Figure 2-2 for details.
Options Dialog Box

Options to save changed files

Options to open and close files

Available distance units

Color options to display traces

Press to reset all settings to the factory default values

Number of recently open files to be displayed under [File] menu (allowed 1 to 99 files)

Figure 2-2: Options Dialog Box.
Help Menu

This menu provides access to the AFL Telecommunications web site and Noyes Test & Inspection web site, Noyes software updates, Trace.Net and OTDRs user’s guides, and information regarding Trace.Net version.
Toolbar

Several of the most commonly used commands can be accessed from the Toolbar. Click on a toolbar icon to execute the associated command.

<table>
<thead>
<tr>
<th>Toolbar Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Locate and open the desired trace file.</td>
</tr>
<tr>
<td>Save</td>
<td>Save a trace file that already exists with its original name.</td>
</tr>
<tr>
<td>Print</td>
<td>Print the displayed trace file.</td>
</tr>
<tr>
<td>Info</td>
<td>Open the Edit Trace Information dialog box.</td>
</tr>
<tr>
<td>Prev File</td>
<td>Open the previous file in the current folder.</td>
</tr>
<tr>
<td>Next File</td>
<td>Open the next file in the current folder.</td>
</tr>
<tr>
<td>Horiz +</td>
<td>Zoom in horizontally around the active cursor.</td>
</tr>
<tr>
<td>Horiz -</td>
<td>Zoom out horizontally around the active cursor.</td>
</tr>
<tr>
<td>Vert +</td>
<td>Zoom in vertically from the trace level at the active cursor.</td>
</tr>
<tr>
<td>Vert -</td>
<td>Zoom out vertically from the trace level at the active cursor.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Un-Zoom</td>
<td>Display the trace view at 100%.</td>
</tr>
<tr>
<td>Re-Zoom</td>
<td>Zoom to the previous zoom level around the active cursor.</td>
</tr>
<tr>
<td>Prev Event</td>
<td>Select the previous event.</td>
</tr>
<tr>
<td>Next Event</td>
<td>Select the next event.</td>
</tr>
<tr>
<td>A-B Cursor</td>
<td>Switch the active cursor.</td>
</tr>
</tbody>
</table>
Trace Graph Window

[B] label indicates a Baseline

1

2

5

4

7

3

Figure 2-3: Trace Graph Window.
The Trace graph window displays OTDR test results in a graph format. Up to six traces can be displayed. The major features of the Trace graph window are explained below.

<table>
<thead>
<tr>
<th>Ref</th>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Trace tab</td>
<td>Displays the name and color of the open trace. If several traces are open, click on a trace tab to display the associated trace graph.</td>
</tr>
<tr>
<td>2</td>
<td>Vertical axis</td>
<td>Shows insertion loss in dB.</td>
</tr>
<tr>
<td>3</td>
<td>Horizontal axis</td>
<td>Shows distance in user-selected units (km, m, mi, kf, ft).</td>
</tr>
<tr>
<td>4</td>
<td>Trace</td>
<td>This is a graph of insertion loss vs. distance.</td>
</tr>
<tr>
<td>5</td>
<td>Cursors A and B</td>
<td>Used to measure insertion loss, power level, reflectance, attenuation, and distance. To make a cursor active, click on the cursor line or label, or click on the Toolbar Cursor icon to toggle between A and B cursors. To move the active cursor, position the mouse pointer on a cursor, then click-and-drag along the trace graph. Also, you may use the Left and Right keyboard arrow keys.</td>
</tr>
<tr>
<td>6</td>
<td>Cursor label</td>
<td>To move the active cursor, position the mouse pointer on a cursor or a cursor label, then click-and-drag along the trace graph.</td>
</tr>
<tr>
<td>7</td>
<td>Event mark</td>
<td>Indicates the location and the number of a saved event. Events are listed in numerical order.</td>
</tr>
<tr>
<td>8</td>
<td>LSA lines</td>
<td>Available for certain loss measurement methods. Used for calculating insertion loss, trace level, and attenuation.</td>
</tr>
<tr>
<td>9</td>
<td>LSA line boundaries</td>
<td>Near and Far LSA line boundaries for each LSA line segment. Used to control length and position (relative to trace segment) of LSA line.</td>
</tr>
</tbody>
</table>
Event Table Window

The [Event table] window allows the user to view test data associated with the trace displayed in the [Trace graph] window. If several trace files are open, click the desired trace [Tab] located on top of the [Trace graph] window to display the [Event table] of the desired trace. Using the [Event] menu, the user may add or delete trace events and edit comments.

Features of the [Event table] window are explained below.

<table>
<thead>
<tr>
<th>Ref</th>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Summary data row</td>
<td>This row contains the summary data of the displayed trace: number of saved events, link loss, link ORL, and link length.</td>
</tr>
<tr>
<td>Ref</td>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>-----</td>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>2</td>
<td>Event type icon</td>
<td>Indicates the event type graphically.</td>
</tr>
<tr>
<td>3</td>
<td>Event number</td>
<td>Displays the number of the saved event in numerical/position order.</td>
</tr>
<tr>
<td>4</td>
<td>Atten. (dB/km)</td>
<td>The dB/km measurement is a slope of the fiber leading to the event. <strong>Note:</strong> When the length of the fiber being measured is insufficient, the dB/km measurement is displayed followed by an asterisk [<em>] symbol. An asterisk [</em>] symbol indicates, “Section is too short to ensure an accurate fiber attenuation (dB/km) measurement.” The required minimum distance is wavelength dependent: 1625 nm = 3 km, 1550 nm = 5 km, 1310 nm = 3 km, 1300 nm = 2 km, and 850 nm = 0.3 km.</td>
</tr>
<tr>
<td>5</td>
<td>Loss (dB)</td>
<td>Shows Insertion loss in (dB) of the fiber segment before the event.</td>
</tr>
<tr>
<td>6</td>
<td>Source</td>
<td>This column indicates how the event is added: • manual - added by operator • auto - event table is generated by OTDR software</td>
</tr>
<tr>
<td>7</td>
<td>Type</td>
<td>This column indicates the event type based on the selected loss method.</td>
</tr>
<tr>
<td>8</td>
<td>Location</td>
<td>Distance from the OTDR (or end of launch cable) to the event.</td>
</tr>
<tr>
<td>9</td>
<td>Refl. (dB)</td>
<td>Reflectance in (dB) for each reflective event</td>
</tr>
<tr>
<td>10</td>
<td>Loss (dB)</td>
<td>Insertion loss in (dB) for each event.</td>
</tr>
</tbody>
</table>
# Keyboard Shortcuts

Available Trace.Net keyboard shortcuts:

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Trace...</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Open Baseline...</td>
<td>Ctrl+B</td>
</tr>
<tr>
<td>Next File</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Prev File</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Add Event</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Delete All Events</td>
<td>Shift+Del</td>
</tr>
<tr>
<td>Restore Event</td>
<td>Shift+Ins</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Active Cursor</td>
<td>Left / Right Arrows</td>
</tr>
<tr>
<td>Zoom in Horizontally</td>
<td>Alt+Right</td>
</tr>
<tr>
<td>Zoom out Horizontally</td>
<td>Alt+Left</td>
</tr>
<tr>
<td>Zoom in Vertically</td>
<td>Alt+Up</td>
</tr>
<tr>
<td>Zoom out Vertically</td>
<td>Alt+Down</td>
</tr>
<tr>
<td>Un-Zoom</td>
<td>F6</td>
</tr>
<tr>
<td>Re-Zoom</td>
<td>F7</td>
</tr>
<tr>
<td>A-B Cursor</td>
<td>F4</td>
</tr>
</tbody>
</table>
Section 3: Transferring Trace Files to a PC

Traces Saved with M200 OTDR
Trace files saved with an M200 OTDR are transferred to a PC using a USB cable.

1. Connect your OTDR to a PC using a mini-USB to USB cable. Make sure the mini-plug is fully seated in your OTDR.
2. On your PC, open the Trace.net software.
3. From the Trace.net File menu, select [M200 Trace File Transfer...] to open the [M200 Trace Transfer] menu (see Figure 3-1).
4. Select source Drive > Folder, and then select traces as required.
   For multiple trace selection, perform the following:
   • Click on the first trace to be added to highlight it.
   • Hold the Shift key to scroll down to the last trace you wish to select, and then click on it.
5. Select destination Drive > Folder.
6. ‘Drag and drop’ files into the destination folder.
Figure 3-1: M200 Trace File Transfer
Traces Saved with M200 OTDRs

Transferring Traces From M200 via USB Function port to PC

To transfer files from your M200 to a PC using a USB cable, perform the following:

1. Connect your M200 to a PC using a mini-USB to USB cable.
   Note: If your PC requests new USB drivers, install the CD-ROM that comes with your M200, which contains the needed drivers. This step only needs to be performed the first time you connect your M200 and PC together.

2. If your PC pops up a dialog box asking if you want to set up a new Partnership, select No (the M200 should always be a ‘guest’).
   - Open My Computer > Mobile Device > File Storage > Internal folder.
   or
   - Open My Computer > Mobile Device > CF folder.

From CompactFlash card or USB Flash drive to PC

To transfer files from your M200 to a PC using your CF card or USB drive, perform the following:

1. Copy any files stored on the M200 Internal Drive to the CF drive or USB drive.

2. Remove the CF card or USB drive from your M200 and read it with your PC.
Traces Saved with OFL250/OFL280 OTDRs

Trace files saved with OFL250/OFL280 OTDRs may be transferred to a PC using the OFL2Go Utility or a USB cable.

To Transfer Files Using OFL2Go

2. Follow the instructions outlined in the OFL2Go Reference Guide.

To Transfer Files Using a USB Cable

1. Connect your OTDR to a PC using a mini-USB to USB cable. Make sure the mini-plug is fully seated in your OFL 250.
2. Press the [USB] soft key on your OTDR.
4. Copy the [Results] folder to your PC.

Note: Before removing the USB cable that connects your OTDR to your PC or pressing the [Cancel] soft key on the USB page, perform the following:

- Left click the Safely Remove Hardware icon - in the Start bar of your PC
- Left click the [Safely Remove USB Mass Storage Device – Drive (?)] message, where ‘?’ is the drive letter assigned to your OTDR
Traces Saved with OFL 200 OTDR

Trace files saved with an OFL 200 OTDR are transferred to a PC using the Trace.Net software. File selection and transfer are done via the [Transfer Files from OFL 200] dialog box, which is accessed from the Trace.Net [File] menu.

OFL 200 File Transfer Dialog Box

The [Transfer Files from OFL 200] dialog box allows you to perform the following tasks:

- Select all or multiple trace files for transferring to a PC.
- Remove all or multiple trace files from the transfer list.
- Rename trace files to be transferred.
- Renumber trace files to be transferred.
- Add information required for traces identification

The table below and Figure 3-2 describe the [Transfer Files to OFL 200] dialog box features.

<table>
<thead>
<tr>
<th>Ref</th>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>[Files on OFL 200] window</td>
<td>Displays a list of trace files saved with an OFL 200 OTDR.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> If trace files are not displayed, select the appropriate Serial Port, and then click on the [Retry] button.</td>
</tr>
<tr>
<td>2</td>
<td>[Port] pull down list</td>
<td>Click on the [Down arrow] button to select the appropriate Serial Port.</td>
</tr>
</tbody>
</table>
Figure 3-2: OFL 200 File Transfer Dialog Box.
<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>[Retry] button</td>
<td>After the appropriate Serial Port is selected, click on this button to display a list of trace files in the [Files on OFL 200] window.</td>
</tr>
<tr>
<td>4</td>
<td>[File Destination] field</td>
<td>This field displays the destination folder on your PC. If needed, you may change destination by clicking [Edit].</td>
</tr>
<tr>
<td>5</td>
<td>[Select All] button</td>
<td>Allows selecting all trace files displayed in the [Files on OFL 200] window. <strong>Note:</strong> To select or deselect files individually, click on the check box of the desired file.</td>
</tr>
<tr>
<td>6</td>
<td>[Select None] button</td>
<td>Allows deselecting all files.</td>
</tr>
</tbody>
</table>
| 7 | Fiber Name: Preview: Cable ID: Fiber Number: End1: End2: Operator 1: Trace Comment: | Check these boxes and use the corresponding text editable fields, if you need to perform the following:  
  - Rename trace files to be transferred.  
  - Renumber trace files to be transferred.  
  - Add information required for traces identification |
| 8 | [Transfer Files] button | Click on this button to start transferring. |
| 9 | [Exit] button | Click on this button to close the [Transfer Files to OFL 200] dialog box. |
Transferring Traces

To transfer trace files from the OFL 200 OTDR to your PC:

1. Turn the OFL 200 OTDR on.
2. Connect the OFL 200 to your PC using the supplied serial cable.
3. You should see the [Remote] soft key label on the OFL 200 display. Press the [Remote] soft key on the OFL 200.
4. Open the Trace.Net software.
5. From the Trace.Net [File] menu, select the [OFL 200 Trace File Transfer] command to display the [Transfer Files From OFL 200] dialog box (see Figure 3-1).
6. From the displayed list, select the files to be transferred. Refer to the section titled “OFL 200 File Transfer Dialog Box” for details.
7. Click on the [Transfer Files] button to start.
8. While transfer is in progress, you will see a transfer progress bar.
   • If needed, you may stop transferring at any time by clicking on the [Cancel] button.
9. When done, click on the [Exit] button.
Section 4: Managing Trace Files

Opening Trace Files

Single-Wavelength or Multi-Wavelength

Trace.Net offers two options for opening and closing trace files. Depending on the user preference setting (Edit > Preferences > Single-Wavelength or Multi-Wavelength), a single-wavelength trace or multi-wavelength trace (dual-wavelength/tri-wavelength trace) may be opened and closed within the current folder. For details, see section titled Edit Menu > Preferences Dialog Box.

If the Single-Wavelength option is enabled, then trace files will be opened and closed one at a time. If the Multi-Wavelength option is enabled, then trace files will be opened and closed in wavelength sets (files with the same name, fiber number, and fiber type but different wavelengths).

In addition to the open single trace or multi-trace file, the user may open a baseline trace for comparison with the current trace/multi-trace. If a tri-wavelength trace and a tri-wavelength baseline trace file are opened, a total of six traces will be displayed at one time.
Opening Trace Files

Opening a Single-Wavelength Trace

1. From the [View] pull down menu, select the [Options] command to display the [Options] dialog box.
2. Select the [Single-wavelength] option, and then click on the [OK] button.

3. There are two ways to open a single trace file:
   - From the [File] pull down menu, select the [Open Trace...] command
     or
   - Click the [Open] icon on the Toolbar

4. When the [Open Trace] window is displayed, locate the drive and directory containing trace files.
5. From the displayed list of traces, select the trace file you want to open.
6. Click on the [Open] button.
Opening a Multi-Wavelength Trace

1. From the [View] pull down menu, select the [Options] command to display the [Options] dialog box.
2. Select the [Multi-Wavelength] option, and then click on the [OK] button.

3. There are two ways to open a trace file:
   - From the [File] pull down menu, select the [Open Trace...] command
   - Click the [Open] icon on the Toolbar

4. When the [Open Trace] window is displayed, locate the drive and directory containing trace files.
5. From the displayed list of traces, select the trace file you want to open.
6. Click on the [Open] button.

Select to open trace files in wavelength sets
Opening Previous or Next Traces

After you open a single trace file or multiple trace file, you may use the [Prev File] and [Next File] commands to display the previous or next trace file or multiple trace file of the same fiber type (MM or SM) in the current folder.

There are three ways to display the previous or following trace or trace pair:

• From the [File] pull down menu, select the [Next File] or [Previous File] command.
• Click the [Next File] or [Prev File] icon on the Toolbar.
• Use the shortcuts: [Ctrl+N] - next trace; [Ctrl+P] - previous trace.

Comparing Traces with a Baseline Trace

Trace.Net allows you to open a baseline trace or trace set for comparison to another trace or trace set. If a tri-wavelength trace and a tri-wavelength baseline trace file are opened, a total of six traces will be displayed at one time.

1. From the [File] pull down menu, select the [Open Baseline...] command.
   • When the [Open Baseline Trace] window is displayed, locate the drive and directory containing trace files.
   • From the displayed list of files, select the trace file you want to open.
   • Click on the [Open] button to open the file.

2. From the [File] pull down menu, select the [Open Trace...] command.
   • When the [Open Trace] window is displayed, locate the drive and directory containing trace files.
From the displayed list of files, select the trace file you want to open.

Click on the [Open] button to open the file.

**Closing Files with Changes**

Two options are available for closing trace files with changes: [Save Automatically] and [Ask “Would you like to save changes?”].

![Image](image.png)

<table>
<thead>
<tr>
<th>[Save Automatically] option</th>
<th>[Ask “Would you Like to save changes?”] option</th>
</tr>
</thead>
<tbody>
<tr>
<td>If a trace file has been edited and not saved, it will be saved automatically before closing. <strong>Note:</strong> [Save Automatically] will overwrite an existing file.</td>
<td>If a trace file has been edited and not saved, a dialog box will appear prompting you to save changes before closing.</td>
</tr>
</tbody>
</table>

To specify how trace files will be closed perform the following steps.

1. From the [View] pull down menu, select the [Options] command to display the [Options] dialog box.
2. Select the desired option, then click on the [OK] button.
Section 5: Analyzing Traces

Moving Cursors and Zooming

The [A] and [B] cursors may be positioned to measure the insertion loss, power level (if applicable), reflectance (if applicable), attenuation (if applicable), and distance between any two points on a trace.

To make cursor positioning easier, Trace.Net provides tools and commands for viewing different parts of a trace graph at various magnifications. [Zoom In] and [Zoom Out] commands let you magnify or reduce the display of any area in the [Trace graph] window.

Trace.Net zooms horizontally around the active cursor and vertically from the trace level at the active cursor.

Selecting the Active Cursor

To make a cursor active, do one of the following:

- In the [Trace graph] window, click on the desired cursor line or label.
- From the Toolbar, click on the [Cursor] button to toggle between cursors.
- From the [View] pull down menu, select the [A-B Cursor] command to toggle between cursors.
- Press the [F4] key on your keyboard to toggle between cursors.

Once the active cursor is selected, it can be moved along the trace graph.
Moving the Active Cursor

To move the active cursor, do one of the following:

- Position the mouse pointer on a cursor line or cursor label, then click-and-drag along the trace graph.
- Use the [Left] and [Right] keyboard arrow keys.
  
  **Note:** The [A] cursor cannot be moved beyond the [B] cursor location, and vice versa.
- Click on an event in the event table, the active cursor will jump to that event on the trace graph.

Zoom In and Out of a Trace

You can magnify or reduce the trace display performing one of the following:

- From the Toolbar, click on the corresponding Zoom button.
  
  ![Horiz +](image)  
  Zoom in horizontally around the active cursor.

  ![Horiz -](image)  
  Zoom out horizontally around the active cursor.

  ![Vert +](image)  
  Zoom in vertically from the trace level at the active cursor.

  ![Vert -](image)  
  Zoom out vertically from the trace level at the active cursor.

**Note:** Each click magnifies the view to the next preset percentage until the limit of magnification is reached.
From the Menu bar, select the [View] pull down menu, and then choose the desired Zoom command.

<table>
<thead>
<tr>
<th>Command</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In Horizontally</td>
<td>Alt+Right</td>
</tr>
<tr>
<td>Zoom Out Horizontally</td>
<td>Alt+Left</td>
</tr>
<tr>
<td>Zoom In Vertically</td>
<td>Alt+Up</td>
</tr>
<tr>
<td>Zoom Out Vertically</td>
<td>Alt+Down</td>
</tr>
<tr>
<td>Unzoom</td>
<td>F6</td>
</tr>
<tr>
<td>Rezoom</td>
<td>F7</td>
</tr>
<tr>
<td>A-B Cursor</td>
<td>F4</td>
</tr>
</tbody>
</table>

Un-zoom and Re-zoom the Trace Display

In the zoomed view, Trace.Net always displays the active cursor area. The [Un-zoom] and [Re-zoom] commands allow you to display different areas of a trace graph at the same level of magnification. If you need to view a different point of the trace, move the active cursor, un-zoom and then re-zoom. Trace.Net will display the new position of the active cursor at the previous zoom level.

Perform the following steps:

1. In the [Trace graph] window, use the [Zoom In] and [Zoom Out] commands to set the desired level of magnification.
2. Click on the [Un-zoom] button to display the trace view at 100%.
3. Relocate the active cursor as needed (or toggle between A and B cursors).
4. Click on the [Re-zoom] button to display the new cursor location at the previous zoom level.

   **Note:** When you toggle between [A] and [B] cursors in the magnified view, the view changes to display area around the selected cursor at the same magnification level.
Selecting Loss Method

For analyzing traces and adding events, Trace.Net offers various Loss methods. The following table gives a summary of the available methods.

<table>
<thead>
<tr>
<th>Loss Method (and applications)</th>
<th>Measured parameters</th>
<th># of cursors</th>
<th># of LSA lines*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two Point (general purpose)</td>
<td>Insertion loss between any 2 points of a trace</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>Single Event (used to analyze connections, splices, faults, etc.)</td>
<td>Location, Reflectance, Insertion loss of any Reflective or Non-Reflective event</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Multiple Event (used if two or more events are too close to use other methods)</td>
<td>Location and combined Insertion loss of multiple events</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Fiber Attenuation (used to measure dB/km of fiber between events)</td>
<td>Attenuation per km ratio of any segment of a trace with no events</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>Start - No Launch Cable (used to set start of fiber level)</td>
<td>Starting location and level of a trace</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>End - No Receive Cable (Used to set end of fiber level)</td>
<td>Location, Reflectance, and Trace level of the fiber end</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

* LSA Line - least squared approximation segment line. Used to reduce the effects of noise and dead zone while calculating insertion loss, trace level, and attenuation.
To select the desired Loss method perform the following:

1. From the Menu bar, choose the [Events] pull down menu.
2. Choose the [Loss Method] command to display a list of the available options.
3. Select the desired Loss method.

**Positioning Cursors Correctly**

Depending on the selected Loss Method, you will need to position cursors and adjust LSA lines (if applicable) properly. The following graphs illustrate position of cursors and LSA lines for the available Loss methods.

**Two Point Loss Method**

4. Position the left cursor at the start of the event.
5. Position the right cursor beyond the event where the trace returns to a constant slope.
6. Read the insertion loss measurement displayed in the [Cursor measurement] window.
**Single Event Loss Method**

Position a cursor at the start of the event.

1. If required, adjust the right LSA line so the Near Right boundary is located beyond the event where the trace returns to a constant slope.

2. Read the insertion loss measurement displayed in the [Cursor measurement] window.

   or

3. From the [Events] pull down menu, choose the [Add Event] command to save.
Multiple Event Loss Method

1. Position the left cursor at the start of the first event.
2. Position the right cursor at the start of the last event.
3. If required, adjust the right LSA line so the Near Right boundary is located beyond the event where the trace returns to a constant slope.
4. Read the insertion loss measurement displayed in the [Cursor measurement] window.
   or
5. From the [Events] pull down menu, choose the [Add Event] command to save.
Fiber Attenuation Loss Method

This method is used just for analyzing a trace.

1. Position left and right cursors on the trace as needed.
2. Read the insertion loss (dB/km) measurement displayed in the [Cursor measurement] window.
Start Loss Method (No Launch Cable)

Position the left cursor at the beginning of the trace (0 meters).

1. If required, adjust the right LSA line so the Near Right boundary is located beyond the reflection where the trace returns to a constant slope.

2. Read the trace level measurement displayed in the [Cursor measurement] window.

   or

3. From the [Events] pull down menu, choose the [Add Event] command to save.
End Loss Method (No Receive Cable)

1. Position the Left cursor at the start of the Far-end reflection.

2. If required, adjust the left LSA line.

3. Read the trace level measurement displayed in the [Cursor measurement] window.
   or

4. From the [Events] pull down menu, choose the [Add Event] command to save.
Adjusting LSA Lines

If events of a trace are located very close to each other, you may have to adjust the LSA Lines. The graphs below illustrate an example of the right LSA line before and after the adjustment.

To adjust LSA lines, position the mouse pointer over an LSA line boundary, then click and drag to the desired location.

**Note:** if you need to restore the original LSA lines lengths values, choose the [Restore LSA Defaults] command from the [Events] pull down menu.
Adding Manual Events

To add manual events, perform the following steps:

1. Select the desired Loss method.
   
   **Note:** Event type displayed in the Event Table will match the currently selected loss method.

2. Move the active cursor to the event to be added.

3. From the [Events] pull down menu, select the [Add Event] command.

4. The [Add New Event] dialog box opens displaying the event data that will be added to the [Event Table] and allowing you to add a comment.

---

**Event data** - this information will be added to the [Event table]

**Comment text field** - this is the text field where you add comments if needed.
5. Type a comment in the Comment text field (maximum 94 characters) if needed.

**Editing Comments**

To edit a comment, do one of the following:

1. In the [Event Table], select the desired event by clicking on it.
   - From the [Events] pull down menu, select the [Current Event] > [Edit Comment...] command to display the [Edit Event] dialog box.
   - Edit comments as needed.
   - Click on the [OK] button to save changes.

   or

1. In the [Event Table], select the desired event by clicking on it.

2. Right-click the selected event, to display a submenu.
   - From the displayed submenu, select the [Edit Event] command to display the [Edit Event] dialog box.
   - Edit comments as needed.
   - Click on the [OK] button to save changes.
Deleting Events

1. To delete an event, do one of the following:

2. In the [Event table], select the desired event by clicking on it.
   - From the [Events] pull down menu, select the [Current Event] > [Delete] command
   or

3. In the [Event table], select the desired event by clicking on it.
   - Right-click the selected event, to display a submenu.
   - From the displayed submenu, select the [Delete Event] command.
Editing Trace Information

Editing a Single Trace

Trace.Net allows you to edit trace information and certain setup parameters. This is done in the [Edit Trace Information] dialog box.

1. To display the [Edit Trace Information] dialog box, do one of the following:
   - From the [File] pull down menu, select the [Edit Trace Info...] command.
   - From the Toolbar, click on the [Info] button.
   - Click on the button.

2. In the [Edit Trace Information] dialog box, edit the desired trace parameters as needed.

3. Choose [OK] to save changes.

Text fields, which allow to view test settings and edit some test parameters (Date, GIR, and Reflectance Threshold)
**Batch Edit**

The Batch Edit feature allows the user to edit all or selected trace properties in multiple trace files in the current folder. This is done in the [Batch Editor] dialog box. The [Batch Editor] dialog box consists of several windows and control buttons. The table below gives a summary of the [Batch Editor] dialog box features.

<table>
<thead>
<tr>
<th>Ref #</th>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>[Directories] window</td>
<td>Allows the user to navigate to the desired folder</td>
</tr>
<tr>
<td>2</td>
<td>[Trace Selector] window</td>
<td>Displays all trace files in the currently selected folder</td>
</tr>
<tr>
<td>3</td>
<td>[Files to Edit] window</td>
<td>Displays all trace files added to the batch edit list</td>
</tr>
<tr>
<td>4</td>
<td>[Add File] button</td>
<td>Adds a single trace or multiple traces to the batch edit list</td>
</tr>
<tr>
<td>5</td>
<td>[Add All Files] button</td>
<td>Adds all traces in the folder to the batch edit list</td>
</tr>
<tr>
<td>6</td>
<td>[Remove File] button</td>
<td>Removes a single trace or multiple traces from the batch edit list</td>
</tr>
<tr>
<td>7</td>
<td>[Remove All Files] button</td>
<td>Removes all traces from the batch edit list</td>
</tr>
<tr>
<td>8</td>
<td>Trace properties check boxes</td>
<td>Selecting a check box will activate the corresponding editable text field</td>
</tr>
<tr>
<td>9</td>
<td>Text editable fields</td>
<td>This section contains text fields where the user enters all information needed to identify traces</td>
</tr>
<tr>
<td>10</td>
<td>[Clear All] button</td>
<td>Clears all the check boxes and text fields</td>
</tr>
<tr>
<td>11</td>
<td>[Process Traces] button</td>
<td>Click on this button to complete changes</td>
</tr>
<tr>
<td>12</td>
<td>[Exit] button</td>
<td>Closes the [Batch Editor] dialog box</td>
</tr>
</tbody>
</table>
To edit all or selected files, perform the following:

1. From the [File] pull down menu, select the [Batch Edit...] command to access the [Batch Editor] dialog box.
2. In the [Directories] window, locate and select the desired folder.
3. Double-click on the selected folder to open it.
4. All trace files in the open folder will be displayed in the [Trace Selector] window.
5. From the displayed list, add the desired traces to the ‘Files to Edit’ list, which will be displayed in the [Files to Edit] window. Use the [Add File] or [Add All Files] buttons for adding trace files.

To add traces to the batch edit list individually, perform one of the following:

- Double-click the desired trace listed in the [Trace Selector] window. The trace added to the batch edit list will appear in the [Files to Edit] window.
- Click on the desired trace listed in the [Trace Selector] window, then click on the [Add File] button. The trace added to the batch edit list will appear in the [Files to Edit] window.

To add a group of traces to the batch edit list:

- Click on the first trace to be added to highlight it.
- Hold the Ctrl key and click on the next trace to be added to highlight it. Or, hold the Shift key to scroll down to the last trace you wish to add to the batch edit list.
- Click on the [Add File] button. The selected traces will appear in the [Files to Edit] window.
To add all traces in the open folder to the batch edit list:
- Click on the [Add All Files] button. The added traces will appear in the [Files to Edit] window.

6. To remove traces from the batch edit list, use the [Remove File] or [Remove All Files] buttons.

**To remove traces from the batch edit list individually, perform one of the following:**
- Double-click the desired trace displayed in the [Files to Edit] window. The trace listed in the [Files to Edit] window will be removed.
- Click on the desired trace displayed in the [Files to Edit] window, then click on the [Remove File] button. The trace listed in the [Files to Edit] window will be removed.

**To remove a group of traces from the batch edit list:**
- Click on the desired traces to be removed to highlight.
- Click on the [Remove File] button. The traces listed in the [Files to Edit] window will be removed.

**To remove all trace files from the batch list:**
- Click on the [Remove All Files] button. All trace names listed in the [Files to Edit] window will be removed.

7. To update trace properties, activate the desired text field.
8. Edit trace information as needed.
Section 6: Printing Trace Reports

Printing a Single Report

Depending on the selected printing style, Trace.Net allows single or multiple trace view reports as follows:

- [Use Multiple Trace View...] style - prints multi-view traces side by side and event tables if available.
- [Use Overlay Trace View...] style - prints all traces as a single view with overlay wavelength graph and event table for each wavelength if available.

To print a single report

1. From the [File] menu, select the [Print] > [Use Multiple Trace View...] or [Use Overlay Trace View...] command.

2. When the [Print] dialog box opens, select the desired printer.
   
   **Note:** If you have a PDF printer installed, you may select it for producing trace reports in the PDF file format.

3. Click OK to print a single trace report.

   **Note:** You may print a single report by clicking on the Toolbar Print icon. In this case, Trace.Net will use the previously selected print style and settings.
Printing Multiple Trace Reports - Batch Printing

For printing multiple trace reports, Trace.Net provides a Batch Print feature, which simplifies printing operations by allowing multiple trace files to be printed simultaneously. Using the [Batch Print] command, all trace files that require printing can be selected and processed at once. This is done in the [Batch Printing] dialog box.

Batch Print Dialog Box

The table below gives a summary of the [Batch Print] dialog box features (refer to Figure 6-1).

<table>
<thead>
<tr>
<th>Ref</th>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>[Directories] window</td>
<td>Allows navigation to the desired folder</td>
</tr>
<tr>
<td>2</td>
<td>[Traces Selector] window</td>
<td>Displays a list of saved traces in the selected folder</td>
</tr>
<tr>
<td>3</td>
<td>[Files to Print] window</td>
<td>Displays all trace files added to the print list</td>
</tr>
<tr>
<td>4</td>
<td>[Trace Preview] window</td>
<td>Allows you to view the selected trace graph</td>
</tr>
<tr>
<td>5</td>
<td>[Cover Page] check box</td>
<td>Check this box if you prefer to print a cover page</td>
</tr>
<tr>
<td>6</td>
<td>[Setup Cover Page] button</td>
<td>Opens the [Cover Page Setup] dialog box for adding information to the cover page</td>
</tr>
<tr>
<td>7</td>
<td>[Add File] button</td>
<td>Adds a single trace or multiple traces to the print list</td>
</tr>
<tr>
<td>8</td>
<td>[Add All] button</td>
<td>Adds all traces to the print list</td>
</tr>
<tr>
<td>9</td>
<td>[Remove File] button</td>
<td>Removes a single trace or multiple traces from the print list</td>
</tr>
<tr>
<td>10</td>
<td>[Remove All Files] button</td>
<td>Removes all traces from the print list</td>
</tr>
<tr>
<td>11</td>
<td>[Zoom] buttons</td>
<td>Allows setting up a zoom level for all traces in the print list</td>
</tr>
<tr>
<td></td>
<td>[Print Options] window</td>
<td>Use this window to select Print Options</td>
</tr>
<tr>
<td>---</td>
<td>------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>13</td>
<td>[Print Files] button</td>
<td>Opens the [Print] dialog box</td>
</tr>
<tr>
<td>14</td>
<td>[Exit] button</td>
<td>Closes the [Batch Printing] dialog box</td>
</tr>
</tbody>
</table>

**Figure 6-1: Batch Print Dialog Box.**
Selecting Traces for Batch Print

1. From the [File] menu, select the [Batch Print] command to access the [Batch Print] dialog box.
2. [Directories] window, locate and select the desired folder.
3. Double-click on the selected folder to open it.
4. All trace files in the open folder will be displayed in the [Traces Selector] window.
5. From the [Traces Selector] window, add the desired traces to the print list, which will be displayed in the [Files to Print] window. Use the [Add File] or [Add All] buttons for adding trace files.

   **Note:** To view a trace graph before adding a trace file to the print list, click on the desired trace listed in the [Traces Selector] window to display it in the [Trace Preview] window.

**To add traces to the print list individually, do one of the following:**

- Double-click the desired trace listed in the [Traces Selector] window. The trace added to the print list will appear in the [Files to Print] window.
- Click on the desired trace listed in the [Traces Selector] window, then click on the [Add File] button. The trace added to the print list will appear in the [Files to Print] window.

**To add a group of trace files to the print list:**

- Click on the first trace to be added to highlight it.
- Hold the Shift key to scroll down to the last trace you wish to add to the batch print list.
- Click on the [Add File] button. The trace names of the selected files will appear in the [Files to Print] window.
To add all trace files in the open folder to the print list:

- Click on the [Add All] button. The added traces will appear in the [Files to Print] window.

6. Use [Zoom] buttons to set horizontal and vertical zoom level for all trace files in the open folder. The zoom level you set for one trace applies to all traces in the current folder.

7. If you need to remove trace files from the print list displayed in the [Files to Print] window, use the [Remove File] or [Remove All Files] buttons.

To remove trace files from the print list individually, do one of the following:

- Double-click the desired trace displayed in the [Files to Print] window. The trace name listed in the [Files to Print] window will be removed.

- Click on the desired trace displayed in the [Files to Print] window, then click on the [Remove File] button. The trace listed in the [Files to Print] window will be removed.

To remove all trace files from the print list:

- Click on the [Remove All Files] button. All trace names listed in the [Files to Print] window will be removed.

8. To create a Cover page for trace reports, click on the [Setup Cover Page] button (refer to the section titled “Creating a Cover Page” for more information).

9. To print a Cover Page in addition to trace reports, verify that the [Include Cover Page] check box is selected.

10. When all settings are complete, click on the [Print Files] button to open the [Print] dialog box and send the batch print job to a printer.
Creating a Cover Page for your Batch Print Job

To create a cover page for a Batch Print Report, perform the following steps.

1. In the [Batch Printing] dialog box, verify that the [Include Cover Page] check box is selected.

2. Click on the [Setup Cover Page] button to access the [Cover Page Setup] dialog box.

3. The [Cover Page Setup] dialog box contains several pages, which allow the user to add [Preparer]/[Customer]/[Project] Information that will appear on the cover page.

4. When you finish entering all the necessary information, click on the [OK] button to return to the [Batch Printing] dialog box.

Preparer Information page allows entering Preparer’s company name and address

Company Information page allows entering Customer’s company name and address

Project Information page allows entering all information needed to identify a project
Thank you for choosing Noyes Test & Inspection

16 Eastgate Park Road
Belmont, NH 03220
Phone: 800-321-5298
       603-528-7780
Fax: 603-528-2025
www.AFLtele.com > Products > Noyes Test & Inspection